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FCC Regulations Compliance (for USA) 
This equipment has been tested and found to comply with the limits for Class B digital device 

pursuant to Part 15 of FCC Rules. These limits are designed to provide reasonable protection 

against harmful interference in a residential installation. This equipment generates, uses and 

may radiate radio frequency energy and, if not installed and used in accordance with the 

instructions, may cause harmful interference to radio communications. However there is there 

is no guarantee that interference will not occur in a particular installation. If this equipment 

does cause interference to radio or television reception, which can be determined by turning 

the equipment off and on, the user is encouraged to try to correct the interference by one or 

more of the following measures: (1) Reorient or relocate the receiving antenna (2) Increase the 

separation between the equipment and receiver (3) Connect to an outlet on a different circuit. 

 

This equipment has been certified to comply with FCC standards, which are applied to the 

USA only. A shielded interface cable should be used according to FCC 15.27(C). 

 

Changes or modifications not expressly approved by the manufacturer could void any 

assurances of safety or performance and could result in violation of Part 15 of the FCC Rules. 

Canadian Department of Communications Statement 
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital 

apparatus set out in the Radio Interference Regulations of the Canadian Department of 

Communications. 

This Class B digital apparatus complies with Canadian ICES-003. 

Radio Interference (210-240V) 
This equipment Complies with EN55022 (CISPER Publication 22)/Class B. 

 

Content: 

 
• Introduction 

• Package Contents 

• Minimum System Requirements 

• Hardware Installation 

• Software Configuration 

• Screen features and menu options. 

• Writing to Embroidery Cards 

• Reading Embroidery Cards 

• Troubleshooting 
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Introduction 
 
The Ultimate Box allows you to write to a blank embroidery card as many designs as 

the card can hold. The best results are achieved by using The Ultimate Box™ with 

The Ultimate Card™ that holds about 500,000 stitches total. You can write designs 

in PES format for Brother, Baby Lock, Bernina Deco, Simplicity formats and White 

or, in HUS format for Viking/Husqvarna embroidery machines.  

 

The Ultimate Box II is equipped with the second card slot that, in addition to 

capabilities of The Ultimate Box, allows working with cards for Pfaff, Bernina 

Artista and Deco 330. 

 

NOTE! Any information that applies to The Ultimate Box, also applies to The 

Ultimate Box II. Additional functions performed only by The Ultimate Box II are 

specified throughout this manual. 

 

You can save designs to your computer by downloading them from the Internet, embroidery 

design cards, CD’s, floppy disks, etc. Using the browsing software supplied, you will 

browse to the Designs folder, select desired patterns and transfer them to the card.  

 

The Ultimate Box writes to and reads from the following cards: 

 

The Ultimate Card, Ver. I and II       – 1Megabyte (8Megabit) blank memory card, the 

largest Brother type (PES) embroidery machines 

can read. 

The Ultimate Card, Ver. III               – 512Kilobyte blank memory card for Pfaff and 

Bernina Artista machines. The Ultimate Box II is 

required. 

The Ultimate Card, DECO330          – 512Kilobyte blank memory card for Bernina Deco 

330 machine. The Ultimate Box II is required. 

 

The Ultimate Box reads and saves designs back to the hard drive of your computer from 

most PES, HUS, Pfaff and Artista cards. 

 

The Ultimate Box can be used with any Embroidery software available on the market to 

create or edit designs.  

 
The Ultimate Box program  
 

The Ultimate Box program is what you use to control the box. When you run the 

Ultimate Box program you will be able to: 

• Look for designs on your computer, including the drives, networks, etc. Many 

formats are read. See website for current listing. 

As of this manual printing: PES, PEC, PHB, PHC, HUS, SHV, VIP, VP3, JEF, JEF+, 

SEW, DST, EXP, XXX, ART (v1- 3), EMB (v1-6), JAN (v1). 

• See designs even if they are in .ZIPs 

• Use designs even in some corrupted .ZIPs. 

• Use a Card Area to see what you will be writing to the card. 
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• See how full the card will be when you write. 

• Print templates of designs to be written (or designs that have been read). 

• Write designs to cards with no practical limit other than card space. 

• Read designs from cards. 

• Save the designs from the cards to a folder. 

• Plug or Unplug the Ultimate Box while the program is open. 

• Cancel or stop an operation at any time. 

• Control how designs get split when using older formats / machines. 

 
The Ultimate Box+ program 

 
The Ultimate Box+ is a software program that adds useful features for embroidering. 

Included are File conversion, Printing, Rotating, Mirroring, and more! These features 

are often found in other programs, requiring two purchases, and more work; you, the 

embroiderer, have to switch back and forth between programs. 

Perhaps the most important feature of The Ultimate Box+ is that it will automatically 

reduce the size of a design to fit the hoop on the machine!  

When you click the Add Designs button, all this happens for you: 

1. The hoop size is set by the Card Format Preferences. 

2. The design gets added to the Card Area. 

3. The design will be resized, with stitches recalculated! 

What could be easier? Yeah! 

Package Contents 

 
• Embroidery Card Reader / Writer Box 

• Re-writable Embroidery Card   

• USB Cable 

• Installation CD 

 
Minimum System Requirements 

 

• IBM PC Compatible or MAC computer* 

• Pentium 166 MHz or equal 

• 32 Mb Memory 

• 16 Mb Available Hard Drive Space 

• USB Port 

• MS Windows 98/ME/2000/XP/VISTA 32-Bit/Vista 64-Bit/7/8 

• Screen Resolution 800x600 

• CD ROM Drive 

 

* MAC users should download and install Emboxer software from 

http://embrilliance.com/emboxer  

http://embrilliance.com/emboxer
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Installation 
 

Windows 8 and 10 users must download, print and follow Windows 8-10 

instructions before taking further installation steps below. 

 
1. Verify Package Contents 

2. Connect USB Cable to the Card Reader / Writer Box.  

3. Attach the other side of the cable to a USB Port of your Computer.  

You can also connect the card reader/writer box to a USB Hub as long as the 

hub has its own power source (not recommended).  

4. Insert the Ultimate Box Installation CD into the CD-ROM drive of your 

computer.  

5. After a short delay, the installation process should start automatically. If not, 

go to “My Computer”, select CD drive and RUN UBSetup104.exe file. 

6. To install Ultimate Box software, follow the onscreen installation  instructions  

using NEXT button to go to the next screen, ACCEPT the  terms and click 

NEXT to proceed with installation, click Finish on the last screen to finish and 

close installation window. 

Note!!! Use CONTINUE ANYWAY (or RUN ANYWAY) option for any 

standard Windows warning messages during non-Microsoft products 

installation. 

7. Open Ultimate Box software, on the first opening the software will 

show this screen below: 

 
8. Use the number that starts with UBxx…from the installation CD in all 

capitals and with the dashes. 

9. After the Serial number is entered, the Registration Screen will open up, 

please fill all the fields and click OK to  register online your copy of the 

software.Use S/N: from the back of the Ultimate Box to fill in the *Serial 

number from the Ultimate field. 

 

 

http://www.vikant-emb.com/downloads/UB%20Win%208-10.pdf
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The Ultimate Box Basic Program Interface: 
 
The Ultimate Box program window contains several areas, shown below. 

 
Ultimate Box program areas. 
 
Title Bar - appears at the top of the Ultimate Box window. 

 

Menu Bar - appears below the Title Bar. The Menu Bar contains the Ultimate Box 

commands. 

 

Folder Tree - Select the folder or .zip file on your computer in which you would like 

to view designs*. 

 

Main Window - The Main Window displays the design thumbnails contained within 

a folder or zip file. A ‘design thumbnail’ is a miniature display of a design in the main 

window. Hovering over your mouse on a design thumbnail allows you to see the basic 

information for that design with pop-up showing the size, stitches and colors counts. 

 

Card Area - The Card Area displays designs either read from or to be written to the 

card, design information is available by hovering over your mouse on the design. 

 

Status Bar - The Status Bar appears at the bottom of your window. 

 

Adjusting the screen layout - You can adjust the amount of space taken up by the 

individual windows by dragging the splitter bars that separate the windows.  



The Ultimate Box User Manual 

Page 7 of 16 

WWW.VIKANT-EMB.COM 

The program will remember your layout between times when it is run. If you need to 

adjust the layout automatically, for instance if your display properties is changed, you 

can select the Tools Menu command, ‘Reset Splitters’. 

 

Managing Folders with the Folder Tree 
If you right-click on the Folder Tree, you will see a popup-menu that allows you to 

Rename, Open or Create new folders. This can save you a lot of time by not having to 

open up the Windows Explorer program (“My Computer”) to browse through your 

folders. 

 
 

Note!!! New Folder will be created with “New Embroidery Folder” name as a 

default. Type in the desired name on the creation or choose RENAME to rename 

new folder after creation. 

 

The Card Area 
 

Inserting Designs into the Card Area 

 - You can use the Add tool to put designs from your computer or 

removable media into the Card Area. Once in the Card Area they can be written to the 

Ultimate Card, printed, etc. When you first open Ultimate Box the Pending folder will 

be empty. 

 

Removing Designs from the Card Area 

 - First, select designs by clicking, Ctrl-Clicking, or select all with Ctrl-a. 

Then use the Remove button to remove designs from the Card Area. This does not 

save or copy the designs; rather it simply removes them from what can be written to 

the card or folder in the Main Window. You can also hit the ‘Delete’ key. 

 

The Card Capacity 

 - Just like a gas tank, this measures how 

much the inserted card can hold as you submit designs from Main Window down 

to Card Area. 
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Writing to Embroidery Cards 

Writing a Card 

 - Use the Write button to transfer your designs from the Card Area to the 

Ultimate Card.  

 

If you have too many designs for the card, you will see a message telling you to 

remove some designs. Because various card formats are handled very differently, it is 

difficult to tell how many designs will fit on a card. 

 

To Write Designs to a Card: 
1. Make sure the Ultimate Card is inserted. 

2. Select the CARD format for the card using the drown-down window on the left 

side of the Card Area. 

3. Select a design from Main Window and click the ADD button to add the 

design down to the Card Area. 

4. When you have finished adding designs to the card area click the WRITE 

button to start writing design(s) to the card.  

5. As a last reminder, the software will ask you to confirm the Write procedure.  

 
     Select YES to start the writing process. Select NO to cancel. 
 

When WRITE operation is complete, take the card out of the reader/writer box, insert it 

into your sewing machine and start embroidering. 

 

Remember, if you do not see a design in the Card Area, it will not be on your card 

when the writing is complete! 

 

WARNING: All data on re-writable embroidery cards will be erased before any 

new information can be written to it. Make sure that any valuable data is saved on 

the hard drive of your computer or move it to the holding area before you write to 

the card. 

 

Write Card Error 
 

If you have chosen more design files then will fit on the card, a warning message will 

appear.   
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1. Click OK. The card is at full capacity, no more designs can be submitted for writing. 

2. Click on WRITE button to write all submitted designs to the card. 
 

Reading Embroidery Cards 

 - Use the Read option to transfer designs from the Card to Ultimate Box. 

When Ultimate Box reads a Card, a copy of each design on the Card will displayed in 

the Card Area. 

 

NOTE!!! All designs in the Card Area are removed and replaced by the designs 

read from the embroidery card.    

 

To Read a Card: 

1. Make sure the card is inserted properly in the Ultimate box. 

2. Click the READ button from the Card Area toolbar. 

 
3. Design filename prefix will be prompted.  Modify this if desired 

and click OK. Designs will use this prefix and be assigned 

sequential numbers. The card is read and the designs are displayed 

in the Card Area. 

4. Use the Folder Tree to navigate to the desired folder. You can 

also create a new folder to store the designs using right click and 

New Folder option. 

5. After the destination folder is selected, click COPY button in the 

Card Area toolbar to save all the designs into the Card Area up to 

the folder displayed in the Main Window. Note that only selected 

designs in the card area are copied. 

Ultimate Box will begin reading the card. Depending on the size and number of 

designs on the card, this may take a few minutes, once completed the designs will 

appear in the Card Area. 
 

Converting Designs 
Using the above sequence, you can also convert designs into the format used by the 

card that’s currently inserted. For example, insert a card into Slot 1 on the Ultimate 

Box and insert some designs into the Card Area. Now select either Brother or Viking 

in the Card format list. The designs in the card area will now be set to that format. You 

can now simply save a copy of the designs, and they will be converted. 
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Unzipping and Repairing Corrupt ZIP Files 
Using the same process as defined above in ‘Converting Designs’, you can unzip a file 

or files. Also in this process, damaged .ZIP headers are repaired automatically. This is 

useful because there are a lot of designs on the Internet that were converted with older 

software known to make those corrupt .ZIPs. 

 

Printing Design Templates 

 - Use the Print button to print actual-size templates for each of the 

designs sent to the Card Area. 

 
The Tools Menu 

 

 
Resetting the Box 
In the highly unlikely event that the program cannot automatically reset the box 

connection, you can try the Reset/Find Box command from the Tools Menu.  

Alternately, unplug and re-plug your box from the computer. 

 

Cancelling an operation 
Sometimes you may realize you’ve started a long write, but forgot to include a design. 

Using this menu command, you can cancel what you are doing and start over. 

 

Splitting designs for a given format 
Use the Card Format Properties command from the Tools Menu to display the Format 

Properties for the selected card format. Designs need to be split due to the limitations 

of embroidery machine hardware. For instance Pfaff 7570 machines cannot use more 

than 16 colors. 
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If you are unsure about these settings, leave them alone or click ‘Use Default’. Your 

Embroidery Machine retailer may be able to help you improve these settings for newer 

machines that do not need to split designs with the same parameters as older machines. 

 

Erasing a Card 
You can manually erase a card if desired (you do not need to) using the Tools Menu 

option, ‘Erase Card’. 

 

Reset Window Splitters 
If you’ve moved your splitters around and simply can’t find them, or if you’ve 

changed your Display Properties in Windows, you can reset the window to look like it 

did on installation. 

 

View Design thumbnails 
If you have a lot of designs to scroll through, it may be faster if the icons are smaller. 

Or if you don’t know where your reading glasses are, maybe the larger icons will be 

easier to see. 

 

View 3D 
Sometimes you want to see the thread texture of the design. This is done with the 3D 

view. 

 

Language 
For delivery in different parts of the world, the Ultimate Box may have language 

options available. Ask your dealer. If there are other languages, you’ll find them on 

the Tools menu, under ‘Language’ 

 
The About Box and Registration update 
 

The About Box contains the copyright for the program and one other useful feature: 

Register. 

If you have moved or changed email, you might want to update your registration with 

us. Clicking on the Register button takes you to a screen where you can make those 

changes. If you’re connected to the Internet, the Ultimate Box program will send a 

message to us with the updated information. 

Privacy Notice: We respect your privacy! We don’t sell your information to anyone. 

That has happened to us and we didn’t like it. 

 
The Ultimate Box PLUS Program Interface additions: 

 

The Ultimate Box PLUS program, available for purchase with the Ultimate Box or as 

an upgrade, contains additional user items: 
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The Toolbar 
The toolbar allows additional features to become available. 

 

Convert 

 - You can save designs as different file types. To use it, select some designs 

that you want to convert. Then click the ‘Convert’ button. 

This will display a window asking you what format you would like to convert into: 

 
Select the format in the box, then click, ‘OK’. Your designs are now converted, and 

exist in the same folder or .ZIP where the original design is.  

Note!!! If the design currently exists in the ‘Convert’ format, a new design will be 

made with a (2), (3), etc. in the filename. 

 

Print 

  - Print full size templates from any designs in view, without adding them to 

the card area. Simply select the designs and click ‘Print’. 
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Fit Automatically 

 - If you want to make a design smaller so that it will fit in your hoop, click 

‘Fit’. This will reduce the size (and stitch count!) of designs to fit in your hoop. The 

‘hoop’ size is what you’ve set in the card preferences for the currently inserted card. 

You will need to have a card inserted for this to work. 

 

Mirror 

 - Create a reverse or ‘mirror-image’ of the designs. 

 

Rotate 

 - Turn the designs to better fit a hoop. 

 

Colors 

 - View the colors on any design your hover the mouse over: 

 

 
 

The pop-up menu 

 
This allows convenient right-click commands to select, delete, print and convert designs.  
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The Design Menu 

 
 

If you have checked, ‘Automatically reduce designs to fit hoop’ then when you add 

designs to the Card Area, they will be resized if they are too large. When resizing is 

done, the stitches are recalculated so that correct density is maintained. 

 

Conversion Preferences 

 
The other options duplicate the Toolbar buttons, with the exception of Set Conversion 

Preferences. Clicking on this brings up the following window: 

 

The controls in this window affect the output of your conversions.  

The first thing to know is that, “If you don’t know, don’t touch.”  

The second thing is that if you’ve made changes and aren’t sure about them, you can 

always click the ‘Use Default’ button. 

 

The controls are as follows: 

• The radio buttons on the left select the format that you’re adjusting. For instance, 

click on PES to adjust the PES conversion preferences. 

• ‘Warn if exceeding’ will direct the program not to convert if the file is too big for 

the new format. 

 



The Ultimate Box User Manual 

Page 15 of 16 

WWW.VIKANT-EMB.COM 

• ‘Split After’ will break a file into two or more files. This is done if the file has too 

many stitches or colors. This is required to accommodate some older machines or 

formats. To stitch the full design, simply sew the split files one right after the 

other. 

• ‘Software supports both hoop orientations’ will allow the design to be rotated 

inside the file if needed. Not all versions of software for a given format will 

understand the file if it is rotated. If you don’t use OEM machine software, leave 

this option on. 

• ‘Rotate design to attempt to fit’ if you don’t have the software check above on, 

this will try saving a larger design into the format by rotating it. Many hoops are 

not square and few designs are, so rotating can allow a bigger file to be saved. The 

only drawback is that it will sew sideways. 

 

Other Options: 

• ‘Convert PES version 5’ allows the file to contain thread color information from 

many brands. If you use PE-Design or Palette versions 1-4, you may not want this 

option, as your software will not read the design. 

• ‘Ensure trims and tie-offs’ allows for the fact that on some machines with 

automatic trimmers, you can force the trim to cycle on jump stitches. 

• ‘Convert 180x300 designs’ allows for a special hoop in PES, and requires a PES 

version 6 file to be written. 

 

Troubleshooting 
 

Card Reader / Writer Box is not found by Software: 
Power is supplied to the Card Reader / Writer box via the USB connection. 

If the box is connected to a USB hub, be sure that the hub has its own power source or 

the box may not have enough power to operate correctly. 

Re-plug the USB cables making sure they are firmly attached then try again. 

 

If during Read/Write procedure an error message appears: 
Close the Card Reader/ Writer software and restart the Reader / Writer box by re-

plugging the USB cables making sure they are firmly attached then try again. If the 

problem persists, contact your dealer or the manufacturer. 

 

Sometimes the box will appear to work, but will fail during a read 

or write: 
This has happened to us and a bad cable was found to be the culprit. 

 

My Box is connected, but the buttons to read and write are grayed 

out: 
If there is no card, or a defective card, the buttons will become disabled, indicated by a 

gray state. Double check that the card is inserted all the way. 

Warranty 
This product is covered by a Limited* One Year Warranty. 

 

*Box and Card Connector defects are not covered by the warranty. Service/repair charge may apply. 
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Technical Support  
Full Technical Support for the operation of the Ultimate Box is provided by Vikant 

Corporation via e-Mail at service@vikant.com 

You can also call us at 888-760-8554 X 203, 847-919-9400 X 203  

or Fax to 847-808-9803 

 

Vikant Corporation 

6577 Windham Lane 

Long Grove, IL 60047 

mailto:service@vikant.com

